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Abstrak 

Perkembangan gedung vertikal menjadi suatu kebutuhan. Hal ini terbatasnya lahan salah satu faktor 

permasalahan khusus di daerah perkotaan, Rentannya struktur gedung vertikal mampu menahan gaya lateral 

pada gempa yang terjadi, Dalam penelitian ini menggunakan sistem rangka pemikul momen biasa tanpa sistem 

dinding geser. Tujuan penelitian mengetahui bagaimana cara mengevaluasi struktur menggunakan analisis 

dinamik metode respon spektrum pada SNI 1726:2019 digunakan untuk menganalisa gedung Jamaliah. Hasil 

analisa menunjukkan partisipasi massa ragam yaitu 91%-93%, gaya geser dasar nominal Vx yaitu 17103,46 

kNdan Vy yaitu 17103,46 kN , waktu getar alami fundamental Tcxyaitu 1,793 s dan Tcyyaitu 1,832 s, gaya geser 

dasar terbesar arah x yaitu 3,46 mm dan y yaitu 15,92 mm, Simpangan antar lantai terjadi rata-rata arah x 

yaitu197,76 mm dan arah y adalah 209,85 mm. Sehingga kerusakan struktur bangunan dianggap lebih 

besarketika terjadi goncangan atau pergerakkan struktur bangunan akibat beban lateral pada beban gempa 

yangterjadi. Sehingga sistem rangka pemikul momen biasa tanpa dinding geser yang terletak di inti bangunan 

pada permodelan ETAB S2016v2.1 dianggap tidak efektif menahan gaya lateral pembebanan gempa 

SNI1726:2019. 
 

Kata-Kata Kunci : Respon Spektrum; Rasio Simpangan Antar Lantai; Gaya Geser Dasar 

 
I. Pendahuluan  
 

Berdasarkan letak geografis, Indonesia 

merupakan daerah rawan gempa bumi vulkanik dan 

tektonik yang dilalui oleh 3 lempeng tektonik dan 

Indonesia memiliki banyak gunung berapi yang 

masih aktif. Tahun 2019 terakhir BMKG mencatat 

lebih dari 17 gempa bumi yang merusak di 

Indonesia salah satunya gempa yang terjadi di 

wilayah Maluku, Banda, Banten dan Laut Banda 

pada 24 Juni 2019 dengan magnitude 6,9 dan 7,3, 

gempa yang memicu tsunami dan likuifaksi serta 

ribuan bangunan runtuh maupun rusak. Perencanaan 

struktur gedung untuk menghasilkan suatu bangunan 

yang aman, nyaman, kuat, efisien dan ekonomis, 

konstruksi gedung harus mampu menahan beban dan 

gaya-gaya yang bekerja pada konstruksi itu sendiri, 

sehingga bangunan atau struktur gedung aman 

dalam jangka waktu yang direncanakan. Salah satu 

komponen yang berperan penting pada struktur 

bangunan adalah beton 

Gedung sekolah Jamaliah Yayasan Syafiatul 

Amaliyah merupakan Gedung sekolah yang 

dibangun untuk pendidikan masyarakat yang 

diharapkan mampu memberikan ilmu pendidikan 

bagi masyarakat yang diharapkan mampu 

memberikan fasilitas umum mengharuskan memiliki 

kekuatan struktur yang sangat kuat untuk 

menghadapi berbagai keadaan, termasuk apabila 

terjadi gempa bumi, oleh karena itu dalam 

perencanaannya harus diperhitungkan beban akibat 

gempa sesuai dengan peraturan yang telah 

ditetapkan. 

Perumusan masalah dalam penulisan penelitian 

ini adalah Gedung Jamaliah Yayasan Syafiatul 

Amaliyah merupakan gedung yang telah dibangun. 

Oleh sebab itu perlu dilakukan analisis kinerja 

struktur dengan metode Respon Spektrum terhadap 

beban gempa berdasarkan SNI1726:2019 yaitu 

mengevaluasi berdarkan kinerja batas layan dan 

batas kinerja ultimate. 

 

II. Tinjauan Pustaka 

 

2.1 Konsep Dasar Mekanisme Gempa 

Bencana gempa bumi dapat menelan banyak 

korban jiwa. Sejarah mencatat gempa bumi 

terdahsyat dalan kurun waktu 50 tahun terakhir 

terjadi di Bio-Bio Chili pada tahun 1960 dengan 

besaran gempa skala 9,5 Magnitude yang dinamakan 

gempa Valvidia. Sedangkan gempa bumi terdahsyat 

dalam 50 tahun di Indonesia tercatat di Aceh pada 

tahun 2004 yang mengakibatkan tsunami dengan 

besaran skala 9,1 Magnitude. 

Gempa bumi adalah getaran yang terjadi di 

permukaan bumi, biasanya disebabkan oleh 

pergerakan kerak bumi (lempeng bumi), gempa 

bumi terjadi apabila tekanan yang terjadi karena 

pergerakan sudah terlalu besar untuk dapat ditahan. 

Gempa bumi terjadi setiaphari di bumi, namun 

kebanyakan kecil dan tidak menyebabkan kerusakan 

apa-apa. Gempa bumi kecil juga dapat mengiringi 

gempa bumi besar, dan dapat terjadi sebelum atau 

sesudah gempa bumi besar tersebut. 

2.2 Sistem Struktur Penahan Gempa 

Acuan dalam perencanaan bangunan beton 

bertulang tahan gempa di Indonesia adalah Standar 

Perencanaan Gempa untuk Struktur Bangunan 

Gedung SNI1726:2012 tetapi SNI gempa 2012 

tersebut sudah direvisi, telah diperbarui lagi yaitu 
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SNI 1726:2019 seiring dengan munculnya peraturan 

terbaru seperti IBC dan ASCE danTata Cara 

Perhitungan Stuktur beton untuk Bangunan Gedung 

SNI 2847:2019 (SNIBeton). Aturan detailing pada 

dasarnya diatur dalam SNI beton, detailing 

dibedakan berdasarkan tingkat kerawanan daerah 

terhadap gempa. Bangunan yang berada pada zona 

dengan resiko gempa yang tinggi harus 

direncanakan dengan menggunakan sistem struktur 

penahan beban lateral yang memenuhi persyaratan 

detailing yang khusus atau memiliki tingkat 

daktilitas penuh. 

 

2.3 PembebananPadaStruktur 

Pembebanan pada struktur merupakan dasar 

dalam merencanakan struktur, hal ini karena tingkat 

keamanan dari struktur bangunan adalah 

berdasarkan beban-beban yang terjadi pada struktur, 

karena struktur yang kuat adalah struktur yang 

mampu menahan semua beban yang terjadi. 

Berdasarkan SNI 1727-2020 Beban desain minimum 

dan kriteria terkait untuk bangunan gedung dan 

struktur lain dibedakan menjadi beberapa jenis, 

yaitu: 

1. Beban mati 

Beban Beban mati adalah beban gravitasi yang 

berasal dari berat semua komponen/bangunan 

yangbersifat permanen selama masa layan struktur 

tersebut. 

2. Beban Hidup 

Beban hidup adalah beban yang terjadi akibat 

adanya hunian, atau penggunaan dari bangunan. 

3. Beban gempa 

Gempa merupakan prilaku alami yang 

keberadaannya diperhitungkan sebagai beban pada 

struktur, beban gempa dapat diartikan dengan beban 

statik ekivalen pada struktur bangunan yang 

bergerak mengikuti pergerakan tanah. 

 

2.4 Analisa ResponSpektrum padaStruktur 

Berdasarkan parameter-parameter di atas 

didapat Respon Spektrum disain pada gedung 

Jamaliah Yayasan Syafiatul Amaliyah untuk daerah 

Medan berdasarkan SNI1726:2019. 

1. Partisipasi Massa 

Ragam Terkombinasi Mengetahui Massa Ragam 

Terkombinasi, Untuk mendapatkan partisipasi massa 

ragam terkombinasi sebesar paling sedikit 90% dari 

massa aktual dalam masing-masing arah dari 

Metode Dinamik Respon Spektrum Menggunakan 

Software ETABS 2016v.2.1. 

2. Gaya Geser Dasar Nominal 

Pada   SNI   gempa   1726:2019   Pasal 

7.9.1.4 disebutkan bahwa nilai akhir respon dinamik 

struktur gedung terhadap pembebanan gempa 

nominal akibat pengaruh gempa rencana dalam 

suatu arah tertentu, tidak boleh diambil kurang dari 

90%  dengan pengecualian nilai respon ragam. 

3. Waktu Getar Alami Fundamental 
Sesuai pasal 7.8.2, perioda struktur fundamental, T, 

yang ditinjau harus diperoleh dengan menggunakan 

property 

strukturdankarakteristikdeformasielemenpenahanada

lamanalisis yang teruji Perioda fundamental, 

T, tidak boleh melebihi hasil efisien untuk batasan 

atas pada perioda yang dihitung (Cu) dan perioda 

fundamental pendekatan (Ta). Sebagai alternatif 

pada pelaksanaan analisis untuk menentukan perioda 

fundamental, T diijinkan secara langsung 

menggunakan perioda bangunan pendekatan. 

 

2.5  Gaya Geser Dasar (Base Shear) 

Berdasarkan peraturan SNI 1726:2019 gaya 

geser dasar dihitung dengan metode statik dan 

dinamik pada dua arah, horizontal danvertikal. Nilai 

gaya geser dasar yang diperoleh dengan metode 

dinamik respons spectrum harus lebih besar 85% 

dari gaya geser berdasarkan perhitungan dengan 

metode statik ekivalen, maka jika nilai gaya geser 

yang diperoleh kurang dari 90%, harus dikalikan 

dengan, dimana V adalah nilai gaya geser dasar 

dengan metode statik, dan Vt adalah gaya geser 

dasar dengan metode dinamik respon spektrum. 

 

Simpangan Antar Lantai 

Berdasarkan SNI 1726:2019 pasal 7.8.6 

disebutkan penentuan simpangan antar lantai tingkat 

desain harus dihitung sebagai perbedaan defleksi 

pada pusat massa di tingkat teratas dan terbawah 

yang ditinjau. 

 

Batasan  Simpangan Antar Lantai 

Simpangan antar lantai tingkat ditentukan 

dalam Pasal 7.12.1, tidak boleh melebihi simpangan 

antar lantai tingkat ijin didapatkan dari Tabel 

untuk semua tingkat. 

 

Bahan Dan Metode 

Untuk mengevaluasi diperlukan sejumlah data-

data umum pada proyek adalah sebagai berikut: 

1. Nama: Proyek Pembangunan Jamaliah Building. 

2. Alamat/Lokasi: Jl. Setia Budi No. 191 Kecamatan 

Medan Selayang (Lintang 3,568221, Bujur 

98,6430471). 

3. Fungsi   : Gedung Sekolah terdiri 1 Lantai Ruang 

Guru 

2 Lantai Ruang Belajar3LantaiRuangTahfiz 

4. TahunPembangunan2019s/dSekarang 

5. Pemilik :Yayasan Pendidikan Syafiatul Amaliyah 

(YPSA) 

6.  

Perencana/ Pelaksana PT. DIAN SAKTI SEMPANA 

 

Data  Geometri  Struktur 

1. Datadimensikolom: 

Kolom adalah bagian utama pada struktur bangunan 

yang fungsinya menahan beban tekan aksial secara 

vertikal, dan meneruskannya sampai pondasi, secara 

umum kekuatan kolom harus lebih kuat dari pada 

balok, makadari itu untuk menahan struktur secara 

keseluruhan didapati berbagai jenis kolom 

sebagaimana berikut: 
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Tabel 1. Detail Dimensi dan Penulangan Pada Kolom 
 

JenisB

alok 

Dimensi(

mm) 

TulanganUta

ma 
Tulangansengkang 

Tumpuan Tumpuan Lapangan 

KolomK1 600x600 24D19 D10-100 D10-100 

KolomK1a 600x600 20D19 D10-100 D10-100 

KolomK1b 600x600 16D19 D10-100 D10-100 

KolomK2 400x400 14D16 D10-100 D10-100 

KolomK3 200x300 10D13 D10-100 D10-100 

Sumber:Shop Drawing 

 

2. Data dimensi balok: 

Balok merupakan bagian dari struktur bangunan 

dengan karakteristiknya yang lentur, 

sehingga balok mampu menahan gaya geser 

dan momen lentur, kemudian 

menyalurkannya menuju kolom, selain 

berfungsi sebagai penyalur beban, balok 

juga berfungsi sebagai pengikat kolom, 

sehingga kolom dapat tetap berdiri tegak 

dan tidak berpindah posisi. Berdasarkan 

gambar rencana proyek didapati bahwa 

jenis balok berbeda, sesuai dengan fungsi 

dan peruntukkannya. 

3. Data dimensi Plat Lantai 

Balok lantai adalah bagian struktur bangunan 

yang terdiri dari tulangan baja dan beton, yang 

berfungsi sebagai tempat berpijak, serta 

menyalurkan beban yang diterima ke balok. 

Berdasarkan Gambar rencana proyek, Struktur 

Gedung Jamaliah didapati ada tujuh jenis plat 

yang digunakan, selain itu digunakan jenis 

tulangan polos untuk setiap penulangan pada 

plat lantai. 

Tabel 3. Detail dimensi plat lantai pada 

strukturgedung Jamaliah 
 

Jenis Plat 
Tebal 

Plat 

(mm) 

Detail Penulangan 

Bentang 

Panjang 

Bentang 

pendek 

Plat Lantai2 150 D10-200 D10-200 

PlatLantai3 150 D10-200 D10-200 

Plat Lantai4 150 D10-200 D10-200 

Plat Lantai5 150 D10-200 D10-200 

Plat Lantai6 150 D10-200 D10-200 

Plat Lantai7 150 D10-200 D10-200 

Sumber: Shop Drawing 

 

4. Prinsip-prinsi Dasar Perancanaan: 

Perancangan struktur Gedung Jamaliah 

Yayasan Pendidikan Syafiatul Amaliyah ini 

mengikuti peraturan dan ketentuan yang 

berlaku di Indonesia. Peraturan-peraturan 

tersebut adalah: 

a. SNI 1726:2019 Tata cara perencanaan 

ketahanan gempa untuk struktur 

bangunan gedung dan nongedung, 

(Mengadopsi Acuan ASCE7-16). 

b. SNI 1727:2020 Beban desain minimum 

dan kriteria terkait untuk bangunan 

gedung dan strukutur lain. 

 

 

c. SNI 2847:2019 Persyaratan beton 

structural untuk bangunan gedung dan 

penjelasan, (Mengadopsi Acuan 

ACI318-14). 

d. Standar atau data lain mengenai berat 

bahan Bangunan. 

 

 

5. Tampak Struktur Gedung Jamaliah Yayasan 

Syafiatul Amaliyah 
 

 

Gambar 1. Tampak struktur bangunan 
Sumber:kontraktorPT.DianSaktiSempana 

 

III. Hasil Dan Pembahasan 

 

3.1  Analisa Respon Spektrum Desain Pada 

Struktur 

Dihitung dengan perhitung anotomatis melalui 

Software RSA 2019-2020 atau Puskim. pu.go.id, 

Respon gempa berbasis kinerja digunakan sesuai 

SNI 1726:2019 didesain kan probabilitas terjadinya 

gempa yaitu 2% dalam kurun waktu 50 tahun atau 

gempa periode ulang 2475 tahun (2/3 × SMS). 

Respon Elastis inimempunyai redaman 5% (redaman 

dasar yang melekat). 

 

3.2 Permodelan Struktur 

Dilakukan dengan bantuan Software ETABS 

2016v2.1 yang dimana program tersebut berguna 

sebagai program dalam menganalisa struktur dengan 

data utama yang digunakan yaitu shop drawing 

Gedung Jamaliah: 

 

1. Membuka Program ETABS 2016 Versi2.1 

 Clickstart→AllProgram→Computers

and

Srtucture→ETABS2016v2.1ataubisajuga

dengan double click icon ETABS 

2016v2.1 pada desktop (jika icon berada 

di desktop). 

 Setelah dibuka program ETABS, Tekan 

Pada Keyboard CTRL + N yaitu 

membuat file baru seperti pada Gambar 

2→Click OK. 
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Gambar 2. Setting awal program baru 

Sumber: Software ETABS 2016v2.1 

 

2. Menentukan  Geometri  Struktur 

 

Gambar 3. Setting geometri struktur  
Sumber: Software ETABS 2016v2.1. 

 

Pada toolbar ‘New Model Quick Template’ seperti 

pada gambar 3, Pilih atau click Custom Grid 

Spacing & Custom story data kemudian isi data-data 

geometri yaitu: 

 Custom grid spacing→Edit data grid 

→Lakukan Grid bangunan arah sumbu X dan Y isi 

data geometri pada Gambar 4 dan isi data pada 

Tabel 2 → Click Ok. 

 

 

Gambar 4. Setting grid geometri struktur 
Sumber:SoftwareETABS 2016v2.1 

 

Tabel 2. Geometri jarak gedung 

Data Geometri Struktur gedung Jamaliah di 

Kategorikan bangunan tidak beraturan (m) 

SumbuX SumbuY SumbuZ 

0,9966 0,925 1 

1,335 0,775  

0,8313 1,575  

0,0437 1,925  

 

Define Material (Mutu Material) 

Untuk menetukan karakteristik dari material-

material tersebut langkah-langkahnya adalah 

sebagai berikut: 

 Click menu Define→Click ‘4000Psi’ → 

ClickModify Show Material, maka akan 

muncul tool bar pada Gambar 5 dan lakukan 

pengisian data: 

 

Gambar 5. Menentukan mutu material pada beton. 
Sumber:SoftwareETABS 2016v2.1 

 

Kemudian lakukan untuk mutu Baja dengancara: 

 Click menu Define → Click ‘A615Gr60’ 

→Click Modify Show Material, maka akan 

muncul tool bar pada Gambar 6 dan lakukan 

pengisian data. 

 

 

 
 

Gambar 6. Menentukan mutu material 

padaTulangan baja. 
Sumber: Soft ware ETABS 2016v2.1 

 

 

Kemudian lakukan pengisian data balok 

dengan cara: 

 Click tool bar‘property name’kemudian 

ubah nama menjadi ‘140/75→Click tool 

bar Material dan pilih‘K-300’→Setting 

Section Dimension isi data Depth =750, 

dan Widht=400→Click‘ modify/Show 

Rebar, kemudian muncul tool bar ‘Frame 

Section Property 

Reinforcement Data ’isi data-data pada 

Gambar 7. 

 

 

Gambar 7. Input data balok  
Sumber: Softw are ETABS2016v2.1 
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Kemudian lakukan pengisian data Pelat 

lantai dengan cara: 

 Click tool bar‘ property name’ kemudian 

ubah nama menjadi ‘Plat Koridor’→Click 

tool bar Material dan pilih ‘K-300’→Click 

toolbar ‘modelling type’ kemudian ubah 

menjadi ‘Shell-Thick’→Setting Slab 

Dimension isi data Thickness=150→Click 

‘modify/Show’, kemudian muncul tool bar 

‘Property/Stiffness Modification Factors’isi 

data-data pada Gambar 8. 

 

 

 

Gambar 8 

 

Define Load Pattern 

 Define→Load Patterns, maka muncul toolbar 

untuk Setting factor beban, Lihat pada 

Gambar 9 → Isi data ‘Live’ dengan‘Self 

Weight Mutiplier’ yaitu 0→Add NewLoad→ 

ClickOk→ClickOk. 

  

 

Gambar 9. Input skala faktor beban 
 

Define Load Combination 

Untuk jenis kombinasi pembebanan diambil 

dari SNI 1726:2019, langkah memasukan 

kombinasi adalah sebagai berikut: 

Define→Load Combination,maka muncul 

 

 toolbar ‘Load Combination, Lihat pada 

gambar 13→Click‘AddNew Combination’ 

maka muncul toolbar ‘Load Combination 

Data’,Lihat pada Gambar 10→Pilih data 

Load Name Dengan ‘Live’yaitu ‘Dead’ 

dan data ‘Scale Factor’ 

yaitu1,2→Add→lakukan berulang sesuai 

kebutuhan data-data, setelah 

selesai→Click Ok. 

 

 

 

 
 

Gambar 10. Input kombinasi pembebanan 

berdsarkan SNI 1726:2019 

 

DefineMassSource 

 Define  →Mass  Source,  maka  muncul 

Toolbar ‘MassSource’, Lihat pada Gambar 

11→Add New Mass Source, maka muncul 

toolbar ‘Mass Source Data’, Lihat pada 

Gambar 11 → Pilih ‘Specified Laod 

Pattern’→Settings ‘Load Pattern’ dan 

‘Multiplier’→Add→Setelah Selesai, Click 

Ok. 

Lakukan Nilai Mass Source: 

Dead: Multiplier 1 

Live: Multiplier 0,25 

SuperDeadLoad:Multiplier 1 

Wall:Multiplier 1 

 

Gambar 11. Input nilai Mass Source 

 

 

3.2 Drawing Model 

1. MenggambarKolom 

 Draw→Draw Beam/Column/Brace 

Object→Kemudian arahkan kursor ke 

titik kolom yang akan di gambar, 

kemudian Click, Lihat pada Gambar 12. 

 

 

 

 

 

 

 

 

Gambar 12. Pemodelan kolom  
Sumber: Soft ware ETABS2016v2.1 
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2. Menggambar Balok dan Balok anak 

 Draw→Draw Beam/Column/Brace 

Object→ Kemudian arahkan kursor 

ke titik balok yang akan digambar 

dan Click, Lihat pada Gambar 13. 

 

 

Gambar 13. Pemodelan balok  

Sumber: Software ETABS2016v2.1 

 

3. Menggambar Pelat Lantai 

 Draw→Draw Floor/Wall Object → 

Draw Rectangular Floor/ Wall (Plan, 

Elev) Kemudian arahkan kursor ke 

titik 1 kolom ke titik kolom ke 2 atau 

dengan klik diagonal yang akan 

digambar, kemudian Click, Lihat 

pada Gambar 14. 

 

 
 

Gambar 14. Pemodelan pelat lantai 
Sumber: Software ETABS 2016v2.1. 

 

4. Memasukkan Tumpuan pada Pondasi: 

 Klik semua Joint atau Blok semua 

joint pada lantai Tanah 

Asli→Restrains→maka muncul Tool 

bar‘Joint Assignment’,→Pilih sendi 

jepit yaitu pilih seluruh ‘Restraints in 

Global Directions’. Lihat Hasil pada 

Gambar15. 

 

Gambar 15. Input sendi jepit  

 

Memasukkan Beban Plat Lantai (Assign 

Load Area) 

 Klik pada pelat yangakan dimasukkan beban 

mati, hidup dan lain-lain→Assign 

→Shell Load→Uniform maka muncul 

Toolbar ‘Shell Load Assignment-Uniform’ 

→Masukkan nilai pembebanan pada 

Uniform load → Replace Existing 

Loads, Liha tpada Gambar 16 

 

 

 

 

 

 

 

 

 

 

 

Gambar 16. Menginput pembebanan merata  
Sumber: Software ETABS2016v2.1 

 

3.3 Analisa Respon Spektrum Pada Struktur 

 

1.  Hasil Output Pembebanan pada ETABS 

 

Tabel 6. Output ETABS pada pembebanan 
Lanta

i/Elev

asi 

Area(

m2) 

DL 

(kN/m) 

LL 

(kN/m) 

SDL 

(kN/m) 

Lantai1 666,52 0,000 0,000 0,000 

Lantai2 747,23 5544,375 10888,69 6530,45 

Lantai3 763,35 30579,38 7331,70 5511,39 

Lantai4 745,32 24603,26 5770,66 4432,87 

Lantai5 775,73 18693,54 4231,76 3371,65 

Lantai6 761 14198,97 3797,70 2160,10 

LantaiAtap 761 6103,97 750,29 1172,33 

Sumber:Output Evaluation ETABS2016v2.1 
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Tabel 7.Output ETABS pada self Mass, Massx & y 
 

Group 
Self Mass 

(kg) 

Self 

Weight 

(kN) 

TotalM

assX 

(kN) 

TotalM

ass Y 

(kN) 

Lt.1 229614,5 2251,78 1203,66 1203,66 

Lt.2 892207,05 8749,70 1044,75 1044,75 

Lt.3 905799,1 8883 12216,8 12216,8 

Lt.4 894349,4 8770,71 15284,4 15284,4 

Lt.5 95716,32 938,67 336,7 336,7 

Lt.6 939422,2 9212,73 15167,5 15167,5 

Lt.Atap 685262,8 6720,24 14680,5 14680,5 

Sumber:OutputEvaluationETABS2016v2.1 

 

2. Gaya Geser Dasar Nominal  
Perhitungan nilai gaya geser

 dasar dalam arah yang ditetapkan 

dihitung berdasarkan SNI Gempa 

 1726:2019 Pasal 7.8.1  Sebagai berikut: 

 

Vx= 0,1812× 94374,94 =17103,46 kN 

Vy=0,1812×94374,94=17103,46Kn 

 

3. Beban Lateral Gempa Arah x dan y 

 

Tabel 8. Output ETABS beban lateral arah x dan y 

 

 

 

4. Waktu Getar Alami Fundamental 

Waktu getar alami fundamental yang 

didapat dari analisis dengan software 

ETABS adalah: 

Tcx = 1,793 sTcy=1,832s 

 

Hasil dari analisis tersebut harus diperiksa 

dengan periode dihitung (Cu) dan periode 

fundamental Pendekatan (Ta). 

Koefisien untuk Cu ditentukan oleh SD1 

adalah 1,4 dan untuk koefisien Ta 

Ditentukan oleh sistem struktur yang 

menahan gaya lateral gedung. Berdasarkan 

SNI 1726:2019 untuk rangka beton 

pemikul momen nilai Ct=0,0466 dan nilai 

x=0,90 Kemudian Perhitungan Ta adalah 

Sebagai Berikut :  

Tamin = Ct×hnx= 0,0466×(46)0,9 

= 1,462s(Lantai 1) 

=0,0466 ×(40)0,9 

= 1,288s (Lantai 2-Atap) 

=0,0466 ×(25)0,9=0,844s 

(Lantai Maintenance)  

Tamax =Cu×Ta= 1,4×1,462 

= 2,047s  

(Lantai 1) 

= 1,4 ×1,288=1,803s  

(Lantai 2-Atap) 

=1,4 ×0,844=1,182 s  

(Lantai Maintenance) 

Syarat: 

Jika Tcomp> Cu. Ta, gunakan Cu .Ta 

JikaTamin < Tcomp, gunakan Cu .Ta Tcomp 

JikaTcomp< Tamin,gunakan Tamin 

 

5. Gaya Geser Dasar (Base Shear) 

Geser dasar seismik dihitung oleh program, 

dengan memasukkan berat jenis beton pada 

awal pengerjaan, yaitu =2400kg/m3. 

 

6. Besarnya Simpangan 

Kriteria persyaratan simpangan mengacu 

pada SNI 03-1726-2019 dengan faktor-faktor 

sebagai berikut : Faktor pembesaran defleksi 

Cd (Tabel 12SNI1726:2019)=2,5 

Faktor Keutamaan gempa, Ie 

(Tabel4SNI1726:2019)= 1,50 

Faktor  redundansi  gedung,

 

Pasal 7.3.4.SNI1726:2019)= 1,30 

7. Simpangan Antar Lantai Ijin Simpangan 

antar Lantai yang diijinkan untuk struktur 

rangka pemikul momen biasa  adalah  (

. Dengan Uraian sebagai berikut : 

Gedung yang digunakan untuk gedung 

sekolah dan fasilitas pendidikan termasuk 

dalam kategori risiko bangunan gedung IV, 

maka nilai faktor 

Keutamaannya sama dengan 1,50. 

Kategori desain seismik D, maka faktor 

redundansi (p) adalah 1,30 (Pasal7.3.4.2). 

Jenis struktur yang dipilih adalah 

SRPMB, maka faktor amplikasi defleksi 

(Cd) adalah 2,50, Kategori risiko IV, 

Simpangan antar lantai ini ijin (

adalah 0,015 hsx. 

 

 

 

Lantai 
Gempa100%arahyangditinjaudan30%arahtegaklurus 

Fx(kN) 30%Fx 

(kN/m) 

Fy(kN) 30%Fy 

(kN/m) 

Base 1203,66 361,10 1203,66 361,10 

Lt.1 1044,75 313,43 1044,75 313,43 

Lt.2 12216,79 3665,04 12216,79 3665,04 

Lt.3 15443,53 4633,06 15443,53 4633,06 

Lt.4 15756,87 4727,06 15756,87 4727,06 

Lt.5 14680,46 4404,14 14680,46 4404,14 

Lt.6 14859,15 4457,74 14859,15 4457,74 

Lt.Atap 14667,65 4400,30 14667,65 4400,30 
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Tabel 10. Output ETABS nilai simpangan 

antar lantai arah y 

 
 

Lantai 

 

Tinggi(

mm) 

SimpanganE

lastis(mm) 

Perpindahany

ang 

diperbesar 

(mm) 

SimpanganA

ntarLantai 

(mm) 

Diizink

an(mm

) 

 

Ket 

Lt. 2 4600 53,186 53,186 131,97 92 
TidakM

emenuhi 

Lt. 3 4000 116,356 63,17 157,93 80 
Tidak 

Memenuhi 

Lt. 4 4000 173,43 57,074 142,69 80 
TidakM

emenuhi 

Lt. 5 4000 238,348 64,918 162,3 80 
TidakM

emenuhi 

Lt. 6 4000 254,38 16,032 40,08 80 Memenuhi 

Lt.

Atap 
4000 275,282 20,902 52,255 80 Memenuhi 

Lt.

Main 
2500 286,758 11,476 28,69 50 Memenuhi 

Lt.

Main 

Lift 

 

1000 

 

281,047 

 

-5,711 

 

-14,277 

 

20 

 

Memenuhi 

Sumber:OutputEvaluationETABS 2016v2.1 

 

 

Gambar 20. Graphics Output ETABS 

nilaisimpangan dan batasan antar 

lantaiSumber:Output 

EvaluationETABS2016v2.1 

 

IV.  Kesimpulan dan Saran 

 

4.1  Kesimpulan 

1. Nilai pada partisipasi massa ragam 

terkombinasi sudah memenuhi dengan hasil 

yaitu 91-93%. 

2. Nilai pada gaya geser dasar nominal pada 

Vx=17103,46Kn dan Vy=17103,46kN. 

3. Nilai waktu getar alami fundamental yaitu 

hasil terbesar yaitu Tcx= 1,793 sdanTcy= 

1,832s 
Nilai gaya geser dasar (baseshear) Terbesar 

 

4. Pada sumbu X= 3,46 mm dan pada sumbu 

Y= 15,92 mm. 

5. Simpangan Antar Lantai terjadi rata-rata 

pada Sumbu X=197,76mm>70,25mm ijin 

rata-rata Simpangan Antar Lantai, maka 

struktur tidak memenuhi Kriteria desain 

sesuai SNI1726:2019 untuk lantai 1-5. 

6. Simpangan Antar Lantai terjadi rata-rata 

pada Sumbu Y=209,85mm>70,25mm ijin 

rata-rata Simpangan Antar Lantai, maka 

struktur tidak memenuhi Kriteria desain 

sesuai SNI1726:2019 untuk lantai 1-5. 

7. Kategori Kinerja struktur pada Gedung 

Jamaliah menggunakan SRPMB dengan 

Evaluasi Berdasarkan SNI1726:2019 tidak 

memenuhi. 

 

4.2  Saran 

1. Diperlukan penelitian lebih lanjut untuk 

mendesain seluruh struktur gedung 

ng mencakup struktur atas dan struktur 

bawah agar lebih mendapatkan hasil yang 

sempurna dalam mendesain suatu bangunan 

gedung. 

2. Dimensi kolom K1 dan K1aek sisting pada 

lantai 1-5 harus diperbesar agar memenuhi 

kriteria desain SNI terbaru. 

3. Dimensi balok induk pada lantai 1-5 harus 

diperbesar agar memenuhi kriteria desain 

terbaru. 

4. Struktur tidak memenuhi kriteria desainsesuai 

SNI 1726:2019 untuk lantai 1-5 ini dapat 

disebabkan karena dalam penelitian ini 

dinding geser tidak diperhitungkan. 

5. Perlu dilakukan penelitian tentang 

seberapa besar pengaruh dinding geser 

terhadap perilaku ketahanan struktur 

dalam menahan beban gempa. 
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